
ContentProtect User Guide 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

© 2004 ContentWatch, Inc. All rights reserved. 
2369 West Orton Circle, Salt Lake City, UT 84119



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 2 

Table of Contents 
 
Welcome and Installation 
Welcome to ContentProtect......................................................................................................................... 4 
System Requirements and Key Features.................................................................................................... 4 
Installation.................................................................................................................................................... 5 
 
Signing In and Out 
Signing In and Out as a User ...................................................................................................................... 7 
Signing In and Out as Administrator............................................................................................................ 9 
 
Opening and Closing 
Opening and Closing ContentProtect ........................................................................................................10 
 
User Profiles 
ContentProtect Windows ...........................................................................................................................12 
Adding a User Profile.................................................................................................................................13 
Filter Settings Overview.............................................................................................................................14 
Changing Filter Settings ............................................................................................................................15 
Denying or Allowing Web, Chat, Newsgroups or Peer-to-Peer Access ....................................................16 
Defining Filter Types..................................................................................................................................17 
Duplicating a User Profile ..........................................................................................................................18 
Adding an Administrator ............................................................................................................................19 
Deleting a User Profile...............................................................................................................................19 
Modifying Profile Settings ..........................................................................................................................19 
Time Restrictions Overview.......................................................................................................................20 
Setting Time Restrictions...........................................................................................................................21 
Modifying Time Restrictions ......................................................................................................................22 
Changing a Password Locally ...................................................................................................................22 
Categories .................................................................................................................................................23 
 
Advanced Options 
Advanced Options Overview .....................................................................................................................25 
Changing the Override Password..............................................................................................................25 
Recategorizing a URL Overview ...............................................................................................................26 
Recategorizing a URL................................................................................................................................26 
Filter Sensitivity Overview .........................................................................................................................27 
Changing Filter Sensitivity .........................................................................................................................28 
Online Updates ..........................................................................................................................................29 
 
Reporting 
Reporting Overview ...................................................................................................................................32 
Local Reporting..........................................................................................................................................33 
Accessing Local Reports ...........................................................................................................................33 
Generating Local Reports for a Specific User ...........................................................................................34 
Generating Local Chat Reports .................................................................................................................35 
Web-based Reporting................................................................................................................................36 
Accessing Web-Based Reporting..............................................................................................................36 
Generating Web-based Reports for a Specific User .................................................................................37 
Customizing Web-based Report Defaults .................................................................................................38 
 
Web Reporting 
Web Reporting Overview...........................................................................................................................39 
Time Spent Online.....................................................................................................................................40 
Web Usage ................................................................................................................................................42 
Categories Logged ....................................................................................................................................44 
Filter Actions ..............................................................................................................................................46 



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 3 

 
Chat Reporting 
Chat Reporting Overview (online reports) .................................................................................................48 
Time Spent in Chat ....................................................................................................................................49 
Chat Messages..........................................................................................................................................50 
Chat Apps ..................................................................................................................................................52 
Chat Sites ..................................................................................................................................................54 

 
Remote Management 
Remote Management Overview................................................................................................................55 
Accessing Remote Management...............................................................................................................56 
Selecting a User for Remote Management ...............................................................................................58 
Changing the Status - Inactive or Active ...................................................................................................58 
Changing a Password Remotely ...............................................................................................................60 
Changing the Access Type........................................................................................................................61 
Changing Override Status .........................................................................................................................62 
Denying Access .........................................................................................................................................63 
Access Status for Categories ....................................................................................................................64 
Recategorizing a URL................................................................................................................................66 
 
Resources 
Glossary.....................................................................................................................................................68 
Frequently Asked Questions (FAQs).........................................................................................................69 
Open Code License Text...........................................................................................................................70 
 
 



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 4 

Welcome to ContentProtect 
Congratulations! You now have the most comprehensive—and yet most easily adaptable Internet filtering 
software available today. ContentProtect comes pre-set to protect you from objectionable and inappropriate 
content. However, we realize that not all users are alike. Each has his/her own values and needs, which is why 
we have developed ContentProtect’s unique filtering process. ContentProtect is customizable for you! 

It is strongly recommended that you read each of the short overviews listed below in the order presented. This will 
give you a good foundation as to how ContentProtect works before you begin using it. 

Sources of help: 

! The ContentProtect User Guide (PDF format) - available from the Help menu within ContentProtect: 

! Step-by-step instruction 

! ContentProtect category list with descriptions 

! Glossary 

! FAQs (Frequently Asked Questions) 

! Comprehensive detailed help with step-by-step instruction - available from the Help menu within 
ContentProtect and web-based reporting. 

! Prompt, competent, and courteous Customer Support by calling 1-800-485-4008 for questions and 
technical assistance. Customer Support is available Monday through Friday, 8 a.m. to 5 p.m. Mountain 
Standard Time. 

! You can email your questions any time to info@contentwatch.com. 

 

System Requirements and Key Features 
System Requirements: 
! PC or Compatible 133 MHz or faster processor 
! Microsoft Windows 98SE/Me/2000/XP 
! 32 MR 
! 20 MB hard drive space 
! CD-ROM drive 
! Color monitor with a minimum 800x600 resolution 
! Internet connection 
! Internet Explorer 4.0 or greater, Netscape 6.0 or greater 

 

Key Features: 
! User-Friendly Interface 
! Client-Based Filtering 
! Server-Based Categorization and Validation 
! Adjustable Filter Sensitivity 
! Unique and Portable User Profiles 
! Web-Based Drill-Down Reports (optional) 
! Override Option 
! Remote User Management (optional) 
! Email Notifications 

mailto:info@contentwatch.com
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Installation 
You must have an Internet connection to install ContentProtect. If you have a dial-up connection, you should 
connect to the Internet before installing. ContentProtect is automatically placed in your startup menu and 
Enabled upon installation. 

If you downloaded ContentProtect from the Internet: 

1. Double click the ContentProtect icon. You will see the ContentProtect setup folders extracting. If you 
are not currently connected to the Internet, you will be prompted to do so. Follow the sign on instructions 
for your particular ISP. 

2. The ContentProtect welcome screen appears. Be sure to read the screen carefully and click Next. 

 
3. Read the License Agreement and if you agree, select I accept the agreement and click Next. 

  

4. Enter the registration number that was emailed to you when you purchased the product online or when 
you requested a trialware number (if you purchased the product in a store, the registration number came 
with your CD). Then click Next. 
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5. If you are satisfied with the default install destination, click Next. Otherwise, specify a different destination 
from the drop-down lists provided, and click Next.  

 
6. Select Set up new account if this is the first time you are installing ContentProtect. 

Note: If you previously set up a ContentProtect account and select Import an existing account, it will 
import all your previous settings. 

If you currently have ContentProtect installed on the machine and you are reinstalling, select Use local 
account. It will keep all your settings. 

 
Note: To import existing accounts: Select Import an existing account, click Next, enter Account Name, 
Administrator ID, and Password, and then click Finish. 

Click Next. 

7. Enter your Last Name, and an Account Name that will be unique to your family. Your Account Name 
will be used to identify your family within the ContentProtect program and will differentiate you from other 
families with the same last name. Click Next. 
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8. Enter an Administrator ID (typically the name of the person who will manage ContentProtect), an 
Administrator Password (passwords are not case sensitive and are limited to 40 characters. Alpha and 
numeric characters can be combined), and Reenter Password to confirm it. Click Finish. 

 
Note: This password will also be the default override password. If you will be sharing the override 
password with others, it is suggested that you create a new override password when you first open 
ContentProtect. After opening ContentProtect, simply click Change Override Password, located under 
Advanced Options. 

9. Review your drive and directory choices, then confirm by clicking Install. 

 
10. Click Finish. This will reboot your computer. You MUST reboot your computer for the installation to be 

complete. 

 
 

Signing In and Out as a User 
In order to use the Internet for browsing or chatting you will be required to sign in to ContentProtect. 
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Note: If you sign in as an Administrator, you will have Administrator privileges, allowing you to modify profile 
settings, filter settings, passwords, and access reporting/remote management (if you are a Premium Service 
subscriber). The Administrator can also customize user profiles and filter settings according to individual needs 
and family values. 

Warning: If you leave your computer without signing out of ContentProtect, others will have access to the 
Internet under your sign-in name and access to your Web and Chat privileges. This means that others using your 
profile will have their Web and Chat activity logged under your name. 

 

Signing In: 

1. Left-click once or right-click the ContentProtect icon from the System Tray located on the taskbar at the 
bottom of your screen . 

2. Select Sign In from the Shortcut menu.  

 
3. Click your user name. 

 
4. The Sign-in Password window will be displayed if the Administrator has required that you enter a 

password in order to sign in. 

5. Type your password.  

 
Asterisks appear as you type to protect your password from being viewed. 

Note: If you don't know your password, ask the Administrator in your home (parent or head of house). 

 

6. Press Enter or click OK. You are now signed in as a user. No other program windows are displayed on 
your screen. 

Note: You now have Web and Chat access according to Administrator settings. You may launch your 
Internet browser and proceed with regular Internet activity. For information about the possible warning 
and block messages you could receive, click here. 
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Signing Out: 

1. Left-click once or right-click the ContentProtect icon located in the System Tray on the taskbar at the 
bottom of your screen . 

2. Select Sign Out from the Shortcut menu.  

 
Note: If the computer is Shut Down without signing out, your session will automatically end. You will have 
to sign in again when the computer is turned on. 

 

Signing In and Out as Administrator 
After ContentProtect has been installed, user profiles will need to be set up to allow other members of your 
family to access online services. You must first sign in as Administrator to create other user profiles. 

Your Administrator account was set up during installation so it's only a matter of signing in with your Administrator 
name and password. As Administrator, you don't have to set up a separate profile for yourself to have Internet 
access. Your Administrator account is also your user profile account. 

Warning: If you leave your computer without signing out of ContentProtect, others will have access to the 
Internet under your sign-in name and access to your Web and Chat privileges. This means that others using your 
profile will have their Web and Chat activity logged under your name. 
 

Signing In as Administrator: 

1. Left-click once or right-click the ContentProtect icon from the System Tray located on the taskbar at the 
bottom of your screen . 

2. Select Sign In from the Shortcut menu.  

 
3. Click your user name (assigned as Administrator).  

 



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 10 

4. The Sign-In Password window is displayed. Type your password. Asterisks appear as you type to 
protect your password from being viewed. 

  

5. Press Enter or click OK. You are now signed in as Administrator. No other program windows are 
displayed on your screen. 

Note: After signing in as Administrator, you will want to open ContentProtect to access User Profiles 
and Filter Settings. 

 

Signing Out as Administrator: 

1. Left-click once or right-click the ContentProtect icon from the System Tray located on the taskbar at the 
bottom of your screen . 

2. Select Sign Out from the Shortcut menu.  

 
Note: If the computer is Shut Down without signing out, your session will automatically end. You will 
have to sign in again when the computer is turned on. 

 

Opening and Closing ContentProtect 
After signing in as Administrator, you can open ContentProtect to access User Profiles and Filter Settings. 

 

Opening: 

1. Left-click once or right-click the ContentProtect icon from the System Tray located on the taskbar at the 
bottom of your screen . 

2. Select Open from the Shortcut menu.  
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3. Click Settings from the selection window.  

 
Note: You can keep ContentProtect running and either minimize or maximize as needed by clicking 
ContentProtect from the taskbar once to minimize and then again to maximize as needed. Be cautious 
about leaving ContentProtect minimized and walking away from your computer as this gives others easy 
access to the program. 

 
 

Closing: 

Closing ContentProtect is different from minimizing the application. Minimizing maintains the last window you 
navigated to in the application and allows you to maximize from the taskbar. Closing the application keeps you 
signed in but is no longer available from the System Tray. 

1. You are signed in as Administrator and have ContentProtect open and displayed on your screen. 

2. Click the "x" located at the upper right-hand corner of the window to close. 

Note: You will have to open the application again and click View Reports or Settings from the selection window 
in order to access the program. 

***Closing ContentProtect does not turn the filter off. 
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ContentProtect Windows 
ContentProtect Application Windows  

 

     
 ......................................................................................................................................................................  
 

Web-Based Reporting and Remote Management Windows 
 

 

 

Add User Delete User Duplicate User User Profile Tab Title Bar Menu Bar Minimize, Maximize and Close Buttons

Left Pane: User Accounts and Advanced Options 

Menu Bar Menu Bar

Filter Settings for Access Type and Categories Time Restrictions Settings Tab 

Reporting Tab Select a User, Date Range and Access 
Type (Chat or Web) and Click Go. 

Select a User and Click Go. Report Management Tab
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Adding a User Profile 
After ContentProtect has been installed, you will want to set up user profiles to allow other members of your 
family to access online services. As Administrator, you don't have to set up a separate profile for yourself to have 
Internet access. Your Administrator account is also your user profile account. 

1. Sign in as Administrator, open ContentProtect, click Settings. 

2. Click Add User  or choose Edit > Add User from the Menu bar. 

3. Observe the User Profile tab. It is displayed by default and the tab is yellow, meaning it is active.  

 
 

4. The Active check box is checked. This will give the user Internet access. 

Note: Leaving this option unchecked or removing the check will disable all Internet access for the user. 
The user will be able to sign in but will not be able to access Internet services. 

5. Click on New User 1 and then type the name for this user in the Name field. 

6. Enter a password in the Password text box. 

Passwords are not case sensitive and have a 40-character limit. Numbers and alpha characters can be 
combined. 

It is suggested to keep a list of passwords and the corresponding user names in a safe place for 
reference. However, the Administrator can change a password for any user, at any time, which eliminates 
the fear of losing or forgetting passwords for access. 

7. The Require password at sign-in check box is checked automatically. 

Not requiring a password is good for users who are too young to type in a password but can click the 
image next to their name at sign-in or for a Guest profile (friends and visitors). It is recommended that 
Filter Settings for password-free profiles be more restrictive than profiles with passwords. 

Note: When a profile doesn't require a password and you click Apply, a warning will be displayed 
cautioning you to have more restrictive profile settings. 

 
8. Other options are as described below for you to choose from: 

Administrator - Check this option to give a user full administrative privilege to change profile settings, 
filter settings, passwords, receive email notifications, and access reporting and remote management. You 
can have as many administrators as you would like. 
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Select Sign-In Image - Clicking this option will display the Sign-In Images window 

  

Click an image to be displayed next to the user's name at sign in. To exit without selecting an 
image, click Cancel or the "x" at the upper right-hand corner of the window. 

Show override button with block message - Check this option to give a user authority to override 
blocked content (you will also be required to enter an Override password for this user at this time). If this 
option is unchecked, the user will be blocked and a standard block message will be displayed when trying 
to access blocked pages. 

Notify Administrator when: 

! User is warned - The action is logged (if logging is enabled for this user), a warning 
message is displayed, and the user can choose to view the content. An email notification is 
sent to the Administrator. 

! User is blocked - The action is logged (if logging is enabled for this user), the requested 
page will not open, and a standard block message is displayed. An email notification is sent 
to the Administrator. 

! User overrides a block - The action is logged (if logging is enabled for this user), and the 
user has been given the password and authority to override the blocked request. An email 
notification is sent to the Administrator. 

9. Click Apply to save changes. Observe the new user name placed in the left pane. 

Note: Clicking Reset will return entries and selections to previously saved settings. 

10. Repeat as necessary until all family members have been set up. 

11. Now you are ready to Change Filter Settings for the new user. After changing Filter Settings, you may 
have more profiles to set up that have the same settings. If so, you can save time by duplicating a user 
profile. 

 

Filter Settings Overview 
Filter Settings are for either Chat (Chat activity), Web (Internet activity), Newsgroups or Peer-to-Peer access. 
Access can be allowed or denied for all four. Only the Web access type can have settings applied to categories 
(Allow, Warn, or Block). Filter settings apply to each individual user. 

Observe the ContentProtect categories listed in the illustration below. By selecting an individual user on the left, 
you can decide how you want each category to be set (Allow, Warn, or Block). A message will be displayed to the 
user to warn or block according to what you have selected. For message examples and descriptions, click here. 
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Categories that are blocked under the Filter Settings tab can be overridden with a password. Just select the 
User Profile tab and check Show override button with block message. This will allow a user to override 
blocked categories. Any user can be given the privilege to override blocked categories. The Administrator must 
give the override password to the user.  

 

Changing Filter Settings 
Default Filter Settings can be changed after ContentProtect has been installed. Filter Settings are for Web 
services such as Chat, Web, Newsgroups and Peer-to-Peer options: access allowed or not allowed. Filter settings 
apply to each individual user. 

1. Sign in as Administrator, open ContentProtect, click Settings. 
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2. Select the Filter Settings tab. The tab color will change to yellow meaning it is active.  

 
3. Select a user from the left pane. 

4. Click the drop-down arrow under Access Type and choose Chat, Web, Newsgroups or Peer to Peer. 

If selecting Web, you can make changes to the access status for each category. Chat, Newsgroups and 
Peer-to-Peer access types do not have categories. Access can be allowed or denied for all four access 
types. 

Note: The Filter Settings tab contains several options that can be applied to each individual user. Log 
Internet Activity is unchecked by default so Internet activities will not be logged for reporting. This option can 
be checked if you do want to log activity for reporting purposes. 

 
Changing the access status for categories: 

1. Make sure Web is selected as the Access Type. 

2. Click the drop-down arrow for the category you want to modify. 

3. Select Allow, Warn, or Block. 

4. Repeat as necessary for each category. 

5. Click Apply to save changes or click Reset to return to previously saved settings. 

Note: If you have similar profiles to set up, save time by duplicating a user profile, which copies all user profile 
entries, selections, and filter settings. 

Denying or Allowing Web, Chat, Newsgroups or Peer-to-
Peer Access 
Access can be allowed or denied for Web, Chat, Newsgroups or Peer-to-Peer. 

1. Sign in as Administrator, open ContentProtect, click Settings. 

2. The Filter Settings tab is selected. The tab color will change to yellow, meaning it is active. 

3. Select a user from the left pane. 

4. Click the drop-down arrow under Access Type and choose Chat, Web, Newsgroups or Peer-to-Peer.  



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 17 

Note: Only Peer-to-Peer applications using the Gnutella protocol will be affected. 

 

5. If there is a checkmark in Access Allowed, click the checkbox to remove the checkmark to deny access. 

Note: When access has been removed, it applies to all web services for Chat, Web, Newsgroups and 
Peer-to-Peer. When a user attempts to use the browser, the following block message will be displayed: 

  

 

6. Click Apply to save changes or click Reset to return to previously saved settings. 

Defining Filter Types 
Allow - The action is logged (if logging is enabled for this user), and provides access without restriction. No 
message is displayed and the user is allowed access to the requested page. 

Warn - The action is logged (if logging is enabled for this user), provides access but warns the user of the types 
of content they are about to view, and lists the category types that caused the warning. A warning message is 
displayed and the user can choose to view the requested page. 

Click Continue (to display the requested web page), Go Back (to return to the previous website), or Re-
Categorize URL (to select a category to assign the URL to and apply by clicking OK).  

  

Block - The action is logged (if logging is enabled for this user), prompts the user that the attempted website is 
being blocked, and lists the category types that have blocked it. The requested page will not open.  

Click Go Back (to return to the previous website).  
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Block with Override option - Prompts the user that they are being blocked and lists the category types that have 
blocked it. Both users and Administrators can override this block with a password. (The Administrator must give 
the override password to the user.) 

Click Override (to enter the override password and then click OK) or Go Back (to return to the previous website).  

 
 Categories that are defaulted to Block a requested page are: 

! Adult/Mature 

! Pornography 

! Drugs/Alcohol 

! Gambling 

! Hate/Violence 

! Illegal Activities 

! Intimate Apparel 

Note: As Administrator, categories set to Block by default can be changed as needed according to your family 
needs and values. 

All other categories are set to allow access. For a list of ContentProtect categories and descriptions click here. 

Duplicating a User Profile 
Duplicating a user profile copies User Profile entries and selections and Filter Settings. If you would like to set 
up a new user based on an existing profile, use the following steps: 

1. Sign in as Administrator, open ContentProtect, and click Settings. 

2. Select the user you wish to duplicate from the left pane. 

3. Click Duplicate User  or choose Edit > Duplicate User from the Menu bar. 

A duplicate user profile of the selected user is created with the name New User 1. 

4. Select the New User 1 in the Name text box. 

5. Type a new name. 

6. Select the text in the Password text box. 

7. Type a new Password. 

8. Click Apply to save changes or click Reset to return to previously saved settings. 
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Adding an Administrator 
Although the original Administrator profile is permanent and cannot be changed, you can assign Administrator 
privileges to other users. Users other than the original Administrator can have Administrative privileges enabled or 
disabled. 

1. Sign in as Administrator, open ContentProtect, click Settings. 

2. Select an existing user from the left pane or add a new user (selecting all appropriate settings). 

3. Check Administrator to give Administrative privileges and to view Administrator Settings.  

  

4. Under Administrator Settings as shown above, check if you want the user to receive email notifications 
and if so, enter an accurate email address.  

5. Click Apply to save changes or click Reset to return to previously saved settings. 

Deleting a User Profile 
You can delete an existing user profile when it is no longer needed. 

1. Sign in as Administrator, open ContentProtect, click Settings. 

2. Select an existing user from the left pane. 

3. Click Delete User  or choose Edit > Delete User from the Menu bar. 

Warning: This action cannot be undone. If a user profile is deleted by accident, it must be created again. 

Modifying Profile Settings 
There may be circumstances where changes to existing profiles will need to be made. You may want to disable 
Internet access, enable the Administrator option, change a password, etc. 

1. Sign in as Administrator, open ContentProtect, click Settings. 
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2. Select an existing user from the left pane. 

3. Make sure the User Profile tab is active and make any necessary changes by: 

• Checking or un-checking profile options. 

• Entering a new user name, password, etc. 

4. Click Apply to save changes or click Reset to return to previously saved settings. 

Time Restrictions Overview 
Time Restrictions are to give you control over the time of day and the amount of time that each individual user 
spends on the Internet. Each day of the week is divided into 30-minute blocks of time and each can be set to 
either allow (green) or block (red) access during that time period. The default is to allow access at all times. 
Settings apply to each individual user. 

Observe the ContentProtect time management grid in the illustration below. 

 
By selecting an individual user on the left, you can decide how much time, during each day of the week, that you 
want to allow or block Internet access for that particular user. Note that green means that Internet access is 
allowed and red means Internet access is blocked. 

Termination of Internet Connection 

Reminder messages will appear in the lower right hand corner of the user’s screen, to indicate that the user will 
be denied Internet access at the end of the 30-minute period. There will be a message indicating that there are 5 
minutes left, another one indicating that there is 1 minute left and a final warning that the Internet connection will 
be terminated in 30 seconds. If an Internet connection is attempted following termination, the user will experience 
a blocked message. 
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The administrator can override a blocked Internet connection with the override password or by adjusting the time 
restrictions for the administrator profile. If the administrator chooses to override the time restriction, surfing will be 
allowed for the next 30-minute block. This time period will end with another series of termination messages. The 
administrator will then be required to override the blocked connection again in order to continue surfing. 

NOTE: The password used to override time restrictions is the same password used to override a blocked web 
site. 

Setting Time Restrictions 
Default Time Restrictions can be changed after ContentProtect has been installed. Time Restrictions apply to all 
Web activity such as Chat, Web, Newsgroups and Peer to Peer. Internet access is either allowed or not allowed. 
Time Restrictions apply to each individual user. 

3. Sign in as Administrator, open ContentProtect, click Settings. 

4. Select the Time Restrictions tab. The tab color will change to yellow meaning it is active.  

 
 

5. Select a user from the left pane. 

6. Click on a row or column or individual block to change the value for that time period. You may also hold 
down the left mouse button and drag to select a range of time blocks. 

7. Remember that a red block indicates that Internet access will be blocked during the specified time period. 
A green block indicates that Internet access will be allowed during the specified time period. Once 
clicked, a green box (access allowed) becomes red (access blocked) and vice-versa. 

8. Click Apply to save changes or click Reset to return to previously saved settings. 
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Modifying Time Restrictions 
There may be circumstances where changes to existing time restrictions will need to be made. To alter Time 
Restrictions settings, simply: 

5. Sign in as Administrator, open ContentProtect, click Settings. 

6. Select an existing user from the left pane. 

7. Make sure the Time Restrictions tab is active and make any necessary changes by: 

• Clicking on a row or column or individual block to change the value for that time period. You may 
also hold down the left mouse button and drag to select a range of time blocks. 

• Remember that a red block indicates that Internet access will be blocked during the specified time 
period. A green block indicates that Internet access will be allowed during the specified time 
period 

8. Click Apply to save changes or click Reset to return to previously saved settings. 

Changing a Password Locally 
The sign-in password can be changed as often as needed. The Administrator can change passwords without 
needing to know the current password being used for a user. A forgotten password is quickly eliminated. 

You can also change a password remotely. Refer to Changing a Password Remotely. 

Important: If the Administrator forgets their Administrator password, choose one of the following: 

! If you have more than one Administrator setup, the other Administrator can tell you your password or 
change your password for you. 

! Send a password request to info@contentwatch.com or call Customer Support at 1-800-485-4008. 
Please provide the following information: 

! Administrator Name 

! Registration Key 

! Account Name 

! Email Address (where to send password) 

! Secret Question 

! Answer to Secret Question 

 

Changing a Password from home (computer with ContentProtect installed): 

1. Sign in as Administrator, open ContentProtect, and click Settings. 

mailto:info@contentwatch.com
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2. Make sure the User Profile tab is selected.  

  

3. Select a user from the left pane. 

4. Select the password text in the Password text box. 

5. Type a new password. 

Passwords are not case sensitive and have a 40-character limit. Numbers and alpha characters can be 
combined. You can change a password remotely. Click here to find out how. 

6. Click Apply to save changes. 

Categories 
The best way to determine the category of a site is to examine the contents. Once you know the information a site 
contains you can more easily assign it to a category. Sites in a given category usually contain the same type of 
links, images, and text. 

ContentProtect does the examining for you and determines which category a requested web page belongs to. 
After the category is determined, Filter Sensitivity adjustments (how strict) and Filter Settings (Allow, Warn, or 
Block) are then applied. Each ContentProtect category is listed and defined below: 

 

 Ads - Advertisements 

Adult/Mature - Sites or resources that contain subject matter intended for mature audiences, such as obscene 
or vulgar language and adult chat rooms. These sites could be considered R-rated. 

Chat - Sites or resources that contain information on chat protocols or applications, links to chat organizations, 
rings, and rooms. 

Drugs/Alcohol - Sites or resources that contain subject matter that deals with the manufacturing, distribution, 
or obtaining illegal drugs, alcohol, or other controlled substances. Sites that depict drug or alcohol paraphernalia 
and/or include methods for obtaining or manufacturing them. Does not include sites that provide information on 
prescription medications except those sites that describe how to illegally obtain them. 

Email - Sites or resources that provide access to email services, and applications. 

 Employment/Career - Sites or resources that allow the posting of jobs or resumes. Sites that provide 
information on compensation in specific fields or regions. Sites that post information about jobs and job openings. 

Family Resources - Sites or resources that provide family counseling, family safety tips, parenting information 
and tips, and family planning. 
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Financial/Stocks - Sites or resources that provide information about finances, financial planning, insurance, 
stock tickers, stock reports, or sites that allow the sell and purchase of stock. Includes banks and credit unions, 
and credit rating and reporting sites. 

Gambling - Sites or resources that allow a person to wager money on online games with the expectation of 
winning money or prizes. Sites that contain links to other gambling sites or provide information on gambling 
strategies or tactics. 

Games - Sites or resources that provide access to online or downloadable games, or discussions about 
games. Sites that provide information about game cheats. 

Government - Sites or resources that are specific to local, state, or federal government organizations or 
agencies, including political party sites and specific, official political sites. Sites ending in .gov. 

Hate/Violence - Sites or resources that promote or depict violence against persons, animals, property, or 
nations. Sites that single out groups for violence based on race, religion, or creed. 

Health/Medicine - Sites or resources that deal with or provide information on mental or physical health issues. 
Sites that allow the online purchase of prescription medications. 

Illegal Activities - Sites or resources that provide information about the manufacture, alteration, or sales of 
weapons. Sites that promote or depict disorderly conduct, or that provide information on the manufacturing of 
explosives and explosive devices. 

Instructional - Sites or resources that contain instructional material, tutorials, or how-to pages. 

Intimate Apparel - Sites or resources that display models wearing underwear, lingerie, or other suggestive or 
see-through attire, including swimsuits. 

Kids - Sites or resources intended for children, including entertainment, education, crisis counseling, and kid-
friendly communities. 

Music/Entertainment - Sites or resources that provide access to free downloadable or for-pay online music 
and video files such as MP3, WAV, MPG, and AVI, etc. Sites that sell music or videos, or that are dedicated to the 
music or entertainment industry. Sites that provide information on TV programs and programming, including 
movie review sites. 

News - Sites or resources that provide live, recorded, or written reports or editorials about current events. 

Personals - Sites or resources that contain personal ads, personal info pages, and personal portals. 

Pornography - Sites or resources that are meant to sexually arouse the viewer. May show models or real 
people that are engaged in erotic behavior intended to cause sexual excitement. May describe sexually explicit 
activities or contain sexually explicit material including images, movies, or text. Sites would be considered X-
rated. 

Religious - Sites that provide information on specific religions or religious beliefs. Regional religious 
organizational sites and sites built to promote religious groups, activities and membership. 

Schools/Colleges - Sites or resources that contain information dealing with colleges, schools, seminars, or 
courses. Sites that end in .edu. 

Search Engines/Portals - Sites or resources that provide mechanisms for searching the Internet by specific 
words or phrases and that display the results as either links or images. Sites that allow a user to customize the 
look or content and that are geared to providing a "starting" place on the Internet. 

Shopping - Sites or resources that provide access to online malls, catalogs, or auctions, including classified 
ads. Department store sites, retail store sites, or sites that have coupons for free or discounted items. 
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Sports  - Sites that promote, advertise, report on or are associated with sports teams, individuals or 
organizations. Sites that are involved with fantasy sports. Sites for organizations whose main focus is to report on 
amateur, college, or professional sports. 

Travel - Online resources that provide information on travel, such as destination descriptions, ticketing and 
reservation sites, airline, bus, or train company sites, car rental sites. 

Work Related - This category allows an organization to add URLs for sites that are used by their organization 
in the course of doing business. It may initially be blank. 

Advanced Options Overview 
Advanced Options affect the entire system rather than a specific user's profile; therefore, you do not need to 
select a specific user when making changes under Advanced Options. 

Advanced options include: 

 

Changing the Override Password 
By default, the password that was entered for the Administrator during installation and setup is also used as the 
override password. If users other than the Administrator will have Administrator privileges and be given the 
override password, it is recommended that a new override password be created. Passwords are not case 
sensitive and have a 40-character limit. Numbers and alpha characters can be combined. 

1. Sign in as Administrator, open ContentProtect, click Settings. 

2. Click Change Override Password under Advanced Options located at the bottom left pane or select 
Options > Change Override Password from the Menu bar. 

  

3. The Change Override Password window is displayed. Enter a new password. 

  



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 26 

4. Click OK to save changes. 

Clicking Cancel will close the window without saving changes. 

Note: This change does not affect the Administrator's password. It remains as entered during installation 
and setup. 

Recategorizing a URL Overview 
Just as ContentProtect examines each web page request for category content to determine which category a 
web site belongs to, the Administrator can recategorize any URL which forces a specific web site to be 
categorized as you choose. Associated Filter Sensitivity adjustments and Filter Settings (Allow, Warn, or Block) 
for that category are then applied. 

Click here for a list of ContentProtect categories and definitions. 

 

Let's consider the following example: 

There is community resource section accessible through the ContentWatch website. Because this section 
contains many educational articles that deal with the problems caused by pornography (and which therefore, 
contain some adult content) a normal filter (ours included) would block this site as Pornography. After going to 
the site and examining the content, it would be clear that it is not pornography and should be recategorized. 

Let's assume you want the URL www.contentwatch.com recategorized as Family Resources. Select the added 
URL (www.contentwatch.com) illustrated below and select the Family Resources radio button. If necessary, go 
to Filter Settings and make sure that Family Resources is set to Allow. This site will now be compared to the 
category Family Resources and access will be allowed.  

 

Recategorizing a URL 
1. Sign in as Administrator, open ContentProtect, click Settings. 
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2. Click Recategorize URL under Advanced Options at the bottom left pane or select Options > 
Recategorize URL from the Menu bar. 

 
3. Observe the Recategorize URL window. You have the power as Administrator to recategorize any URL 

(Universal Resource Locator) if you feel the content belongs to another category. 

 
4. Accurately enter the URL in the text box above the Add and Remove buttons. 

Note: You can copy the URL from the browser and paste it in the URL text box for accuracy. Always 
include the (www), i.e., www.contentwatch.com. 

5. Click Add. The URL will be added to the list. 

6. Make sure the URL just added is selected from the list. 

7. Locate and select a category from the dropdown menu to assign the URL. 

8. Click Done to save changes. 

It is suggested to go to Filter Settings and check category settings for Allow, Warn, or Block as 
appropriate for user needs. 

Filter Sensitivity Overview 
The Filter Sensitivity feature allows parents to determine how strict the filter will be to allow more or less of a 
specific kind of web content. This is accomplished by adjusting the Filter Sensitivity for any chosen category. 

Imagine sliding or turning the adjustment on a toaster to get lighter or darker toast, you can drag the slider bars 
for Filter Sensitivity to adjust how strict the sensitivity will be for the filter. 

ContentProtect examines each web page request for category content. Web page content is then compared to 
how strict the Filter Sensitivity has been set in order to activate Filter Settings (Allow, Warn, or Block). 

 

http://www.contentwatch.com/
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Filter Sensitivity: 

 
! Sliding the bar all the way to the left to More Restrictive tells the filter that all web page attributes will be 

compared for that category. This means less category content is needed to tell ContentProtect to apply 
Filter Settings (Allow, Warn, or Block). 

! Sliding the bar all the way to the right to Less Restrictive tells the filter that no web page attributes will be 
compared for that category. This means more category content is needed to apply Filter Settings. 

! Slider bars set between More Restrictive and Less Restrictive compare web page attributes 
accordingly. 

Consider the following example: 
 
The administrator has chosen to block the category Adult/Mature. A web page might have some content (perhaps 
very little) that would be considered adult/mature. If the sensitivity setting for adult/mature is set to be more 
restrictive, then the page will be categorized as adult/mature and will subsequently be blocked (since the category 
Adult/Mature is set to be blocked). On the other hand, if the category Adult/Mature is set to “Allow”, then that 
same web page which contains Adult/Mature content, will never be blocked, even if the sensitivity setting is set to 
be more restrictive. 
 
The important thing for you to remember is that content is blocked, warned, or allowed by category and not by 
sensitivity. Sensitivity simply means the content is more likely or less likely to be of a certain category. 

Changing Filter Sensitivity 
1. Sign in as Administrator, open ContentProtect, click Settings 

2. Click Change Filter Sensitivity under Advanced Options at the bottom of the left pane or select Options 
> Adjust Filter Sensitivity from the Menu bar.  
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3. Observe the Filter Sensitivity window.  

 
4. Drag the slider bar to the left or right to indicate how sensitive you would like the filter to be for a specific 

category. 

Note: The important thing for you to remember is that content is blocked, warned, or allowed by category 
and not by sensitivity. Sensitivity simply means the content is more likely or less likely to cause a web 
page to be assigned to a certain category. 

For example: The administrator has chosen to block the category Adult/Mature. A web page might have 
some content (perhaps very little) that would be considered adult/mature. If the sensitivity setting for 
adult/mature is set to More Restrictive, then the page will be categorized as adult/mature and will 
subsequently be blocked (since the category Adult/Mature is set to be blocked). On the other hand, if the 
category Adult/Mature is set to Less Restrictive, then that same web page which contains Adult/Mature 
content, will never be blocked, even if the sensitivity setting is set to be More Restrictive. 

5. Click OK to save changes. 

Note: Clicking Cancel will close the window without saving changes. 

Online Updates 
You can check for ContentProtect Online Updates anytime from Advanced Options or the menu bar. 
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Option 1: 

1. Click Online Updates from Advanced Options.  

 
ContentProtect will automatically check and download any updates to the program. 

2. Click OK. 

  

Option 2: 

1. Left or right-click ContentProtect  from the system tray to display the menu.  

 
2. Select Updates. 

 

ContentProtect will open the ContentWatch Updater utility.  

To check for updates, click the “Check for Updates” Button. 
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If there is an update available, click Get Updates 

 
After the update has been installed, you may be asked to restart your computer for the changes to take effect.  

 
Updater Preferences: 

You may also change the preferences of the updater so it will automatically look for and install updates when they 
are available. 

1. Select Preferences > Change Preferences from the menu bar.  



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 32 

2. Make any changes and click OK or Apply to save the changes or Cancel to close the window without 
saving any changes.  

             
When an update is automatically installed, it will display a notification window above the system tray. Restart the 
computer for the changes to take effect. 

 

Reporting Overview 
There are two different reporting options within ContentProtect. The default reports are located on the machine 
where ContentProtect is installed and are available free of any additional charge. These are called Local 
Reports. In addition, there is a Web-based reporting option, which is a Premium Service. This option is enabled 
through a monthly or an annual subscription. 
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Local Reporting 

ContentProtect provides comprehensive local reporting that is accessible by the Administrator for each user or 
for the entire family. Each chart has drill-down capability in order to see transaction detail. Reports are accessible 
to the Administrator on the machine where ContentProtect is installed.  

   
 

Accessing Local Reports 
There are three different ways to access local reports: 

 

Option 1: 

1. Sign in as Administrator and open ContentProtect to view the selection window for View Reports or 
Settings. 

2. Click View Reports. 

 
 

Option 2: 

1. Sign in as Administrator and open ContentProtect to view the selection window for View Reports or 
Settings. 

2. Click Settings. 

3. Select File > Reports from the Menu bar. 
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Option 3: 

1. Sign in as Administrator and left-click once or right-click the ContentProtect icon from the System Tray 
located in the Taskbar at the bottom of your screen . 

2. Select Reports from the Shortcut menu. 

Generating Local Reports for a Specific User 
To generate local reports, you must use the computer where ContentProtect is installed. 
 

1. Sign in as Administrator, open ContentProtect, click View Reports.  
 

             
2. Graphical View will display by default and will display the following Graphs: 

• Time Spend Online 

• Web Usage 

• Categories Logged 

• Filter Actions 

 

3.  To see transactions, click Detail View 
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4.    Select a user from the User List located in the left panel 

5. Web Report Detail will appear in main window  

6. To see complete URL, Filter Action, Category & Date & Time, double click on a URL. A secondary page 
will open displaying this information. To close this page, click the “X” on the upper Left corner. 

 
 

Generating Local Chat Reports  
To generate local chat reports, you must use the computer where ContentProtect is installed. 
 

1. Sign in as Administrator, open ContentProtect, click View Reports.  
2. Click Chat 

 
Graphical View will display by default and will display the following Graphs: 
 

• Time Spent In Chat 
• Chat Messages 
• Chat Apps 

 
1. To view the Chat Detail Report, Click Detail View 
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2. All Chat logs will be displayed in the main window. To see a specific user’s chat logs, click on the 
username located in the Left panel. 

    
 

Web-based Reporting  
In addition, ContentProtect provides comprehensive Web-based reporting (as a subscription Premium Service) 
that is remotely accessible by the Administrator for each user or the entire family. Each chart has drill-down 
capability for transaction detail. Selecting a user, date range, and access type (Chat or Web) will generate charts 
that report transaction detail. Reports are password-protected unless accessed by the Administrator from the 
ContentProtect Administrator application. 

 

Accessing Web-Based Reporting 
Web-based reporting is a Premium Service and is enabled through a monthly or an annual subscription. There 
are four different ways to access web-based reporting, once they are enabled: 

 



 

ContentWatch, Inc.  
ContentProtect User Guide 

Page 37 

Option 1: 

1. 

2. 

3. 

Sign in as Administrator on the machine where ContentProtect is installed and open ContentProtect 
to view the selection window for View Reports or Settings. 

Click Settings. 

Select File > Remote Tools from the Menu bar. 

Option 2: 

Sign in as Administrator on the machine where ContentProtect is installed and left-click once or right-
click the ContentProtect icon from the System Tray located in the Taskbar at the bottom of your screen 

. 

1. 

2. Select Remote Tools from the Shortcut menu. 

  

Option 3: 

1. Type cp.contentwatch.com into the Address or Search bar of the browser from any computer with 
Internet access. 

2. Press Enter. 

3. Enter your ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD. 

4. Click LOG IN. 

Generating Web-based Reports for a Specific User 
The following steps are based upon using the computer with ContentProtect installed. 

Note: If you are away from the family computer, you can sign in on any computer with Internet access (if you are 
a Premium Services subscriber). Choose one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

! Type www.contentwatch.com in the Address bar of your browser and press Enter. Locate and click the 
link to access Web-based Reporting. You can then sign in from the sign in screen. 

 
3. Sign in as Administrator, open ContentProtect, click Remote Tools. 

When Remote Tools is selected, your browser will be launched to access Web-based reporting. 

2. Enter ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD. 

3. Click SIGN IN. 

4. The Reporting tab should be displayed. The tab is yellow meaning it is active.  

 
4. Click the drop-down arrow under User to display a user list. 

5. Select a user. 

6. Click the drop-down arrow under Date Range and select Today, Yesterday, Last 7 days, or Last 14 
days. 

7. Click the drop-down arrow under Access Type and select which type of report you would like to generate 
- Chat (Chat activity), Web (Internet activity), or Peer-to-Peer. 

8. Click Go. 
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Reports will be generated according to the selected user, date range, and access type. Observe the 
sample graph reports below for Chat or Web activity. 

 

Customizing Web-based Report Defaults 
The default report that is displayed automatically when viewing the Reporting tab can be customized. 

The following steps are based upon using the computer with ContentProtect installed. 

Note: If you are away from the family computer, you can sign in on any computer with Internet access (if you are 
a Premium Services subscriber). Choose one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

! Type www.contentwatch.com in the Address bar of your browser and press Enter. Locate and click the 
link to access Web-based Reporting. You can then sign in from the sign in screen. 

 

1. Sign in as Administrator, open ContentProtect, click Remote Tools. 

2. Enter ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD. 

3. Click SIGN IN. 

4. Make sure the Reporting tab is selected, and click Customize Defaults. 

5. Select desired options: 

 

Default Report Options: 

1. Select a specific User or the entire family to be displayed by default when accessing the Reporting tab. 

2. Select a default Date Range. 

3. Select a default Access Type: Chat or Web services. 
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4. Select which Time Zone will be used by default. 

 
  

Default Graph Style: 

Select from the three format styles as the default graph style when viewing reports. 3. 

 
4. Click Apply to save your changes and return to Reporting. 

 

Web Reporting Overview  
When enabled through a subscription-based Premium Service, Web-based reporting on each individual user or 
the entire family is remotely accessible. 

Each chart has drill-down capability for Web Report Detail. Selecting a user, date range, and access type (Web) 
will generate charts that report transaction detail. 

 
 

User Date Range Access Type Time Zone
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Time Spent Online 

A column chart that represents time spent online. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Web if necessary. 

  

4. Click GO. 

5. Observe the Time Spent Online report graph. Resting the mouse pointer over a column marker will 
display the time spent online within a selected date range. 

  

6. Click a column marker to generate and display Web Report Detail. 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 
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8. Click a number (representing how many times a specific website was accessed) under the # of Visits 
column to generate a table listing the exact path of each website. This is the last level of report 
transaction. 

9. Observe the table. Column headings are URL, User, Time, Filter Action, and Category. 

 
Let's define each column of transaction detail: 

URL - Lists the Universal Resource Locator (URL) or address of a specific website accessed by a 
user. Click any URL within this column to open the specific site in a separate window for your 
review. 

Warning: If you are accessing reports from a remote computer that does not have 
ContentProtect installed, blocked websites will be fully displayed. Computers that have 
ContentProtect installed will not display the website unless the Administrator uses the override 
option or allow that specific category. Close the browser or leave the browser open and click 
ContentProtect from the system tray to maximize Web Report Detail. 

User - Lists the user account which was used to access the URL. This is the last level of report 
transaction. 

Time - Reports the hours and minutes spent at a specific website. This is the last level of report 
transaction. 

Filter Action - Reports the filter setting that was applied. The filter setting is set as Allow, Warn, 
or Block for each category. This is the last level of report transaction. 

Category - Displays the category icon(s) associated with each URL. Resting your mouse pointer 
over a category icon will display what that category is. Click here for a list of Category's and 
descriptions. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs or Web Report Detail located below the table or clicking the 

Reporting tab will refresh Web activity and return to reporting. 

 
! Clicking Back from the Standard Buttons toolbar in your browser will return to Reporting but will not 

refresh Web activity. 
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Recategorizing from second level reports: 

1. The second level of Web Report Detail is displayed as in Step 9 above. 

2. Click [Recategorize] to recategorize the website (i.e. gambling.com), if necessary. 

 
3. Select a new category from the drop-down list. 

 
4. Click Recategorize to apply the changes. 

5. To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 

Web Usage 

A line chart that represents the number of Web requests on an hourly or daily basis. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Web if necessary. 
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4. Click GO. 

5. Observe the Web Usage report graph. Resting the mouse pointer over any portion of the line chart 
displays the number of pages browsed within a selected date range. 

  

6. Click on a specific portion of the line chart to generate and display Web Report Detail. 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 

  

8. Click a number (representing how many times a specific website was accessed) under the # of Visits 
column to generate a table listing the exact path of each website. This is the last level of report 
transaction. 

9. Observe the table. Column headings are URL, User, Time, Filter Action, and Category. 
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Let's define each column of transaction detail: 

URL - Lists the Universal Resource Locator (URL) or address of a specific website accessed by a 
user. Click any URL within this column to open the specific site in a separate window for your 
review. 

Warning: If you are accessing reports from a remote computer that does not have 
ContentProtect installed, blocked websites will be fully displayed. Computers that have 
ContentProtect installed will not display the website unless the Administrator uses the override 
option or allow that specific category. Close the browser or leave the browser open and click 
ContentProtect from the system tray to maximize Web Report Detail. 

User - Lists the user account which was used to access the URL. This is the last level of report 
transaction. 

Time - Reports the hours and minutes spent at a specific website. This is the last level of report 
transaction. 

Filter Action - Reports the filter setting that was applied. The filter setting is set as Allow, Warn, 
or Block for each category. This is the last level of report transaction. 

Category - Displays the category icon(s) associated with each URL. Resting your mouse pointer 
over a category icon will display what that category is. Click here for a list of Category's and 
descriptions. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs or Web Report Detail located below the table or clicking the 

Reporting tab will refresh Web activity and return to reporting. 

 
! Clicking Back from the Standard Buttons toolbar in your browser will return to Reporting but will not 

refresh Web activity. 

  

 

Categories Logged 

A pie chart that represents ContentProtect categories that have been browsed by a specific user during a 
specified date range. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Web if necessary. 

  

4. Click GO. 
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5. Observe the Categories Logged report graph. Resting the mouse pointer over any portion of the line 
chart displays the number of pages browsed within a selected date range. 

  

6. Click a pie wedge to drill down and display all websites browsed within a specific category. 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 

 
8. Click a number (representing how many times a specific website was accessed) under the # of Visits 

column to generate a table listing the exact path of each website. This is the last level of report 
transaction. 

9. Observe the table. Column headings are URL, User, Time, Filter Action, and Category. 

 
Let's define each column of transaction detail: 

URL - Lists the Universal Resource Locator (URL) or address of a specific website accessed by a 
user. Click any URL within this column to open the specific site in a separate window for your 
review. 
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Warning: If you are accessing reports from a remote computer that does not have 
ContentProtect installed, blocked websites will be fully displayed. Computers that have 
ContentProtect installed will not display the website unless the Administrator uses the override 
option or allow that specific category. Close the browser or leave the browser open and click 
ContentProtect from the system tray to maximize Web Report Detail. 

User - Lists the user account which was used to access the URL. This is the last level of report 
transaction. 

Time - Reports the hours and minutes spent at a specific website. This is the last level of report 
transaction. 

Filter Action - Reports the filter setting that was applied. The filter setting is set as Allow, Warn, 
or Block for each category. This is the last level of report transaction. 

Category - Displays the category icon(s) associated with each URL. Resting your mouse pointer 
over a category icon will display what that category is. Click here for a list of Category's and 
descriptions. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs or Web Report Detail located below the table or clicking the 

Reporting tab will refresh Web activity and return to reporting. 

 
! Clicking Back from the Standard Buttons toolbar in your browser will return to Reporting but will not 

refresh Web activity. 

Filter Actions 

A bar chart that represents filter responses to a website request showing if a specific transaction was blocked, 
warned, overridden, or logged. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Web if necessary. 

  

4. Click GO. 
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5. Observe the Filter Actions report graph. 

  

6. Click on a bar to drill down and display each transaction for a chosen filter action. 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 

  

8. Click a number (representing how many times a specific website was accessed) under the # of Visits 
column to generate a table listing the exact path of each website. This is the last level of report 
transaction. 

9. Observe the table. Column headings are URL, User, Time, Filter Action, and Category. 

 
Let's define each column of transaction detail: 

URL - Lists the Universal Resource Locator (URL) or address of a specific website accessed by a 
user. Click any URL within this column to open the specific site in a separate window for your 
review. 
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Warning: If you are accessing reports from a remote computer that does not have 
ContentProtect installed, blocked websites will be fully displayed. Computers that have 
ContentProtect installed will not display the website unless the Administrator uses the override 
option or allow that specific category. Close the browser or leave the browser open and click 
ContentProtect from the system tray to maximize Web Report Detail. 

User - Lists the user account which was used to access the URL. This is the last level of report 
transaction. 

Time - Reports the hours and minutes spent at a specific website. This is the last level of report 
transaction. 

Filter Action - Reports the filter setting that was applied. The filter setting is set as Allow, Warn, 
or Block for each category. This is the last level of report transaction. 

Category - Displays the category icon(s) associated with each URL. Resting your mouse pointer 
over a category icon will display what that category is. Click here for a list of Category's and 
descriptions. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs or Web Report Detail located below the table or clicking the 

Reporting tab will refresh Web activity and return to reporting. 

 
! Clicking Back from the Standard Buttons toolbar in your browser will return to Reporting but will not 

refresh Web activity. 

Chat Reporting Overview (online reports) 

Chat reporting is available through both local and Web-based reporting. Web-based chat reporting, when enabled 
through a subscription-based Premium Service, is remotely accessible by the Administrator for each user or the 
entire family.  

Each chart has drill-down capability for transaction detail. Selecting a user, date range, and access type (Chat or 
Web) will generate charts with report transaction detail. 
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Time Spent in Chat  

A column chart that represents time spent in Chat within a specified date range. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Chat if necessary.  

  

4. Click GO. 

5. Observe the Time Spent in Chat report graph. Resting the mouse pointer over a column marker displays 
a numeric value of time spent within a specified date range. 

  

6. Click a column marker to drill-down to Chat Report Detail. A table displays an individual user summary 
listing names (User), the number of messages (Count), and time spent (Time Spent). 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order.  
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8. Click a user name to drill-down another level to chat transactions. 

9. Observe the table. This is the last level of transaction information.  

 
Let's define each column of information detail: 

Time - Time is listed in ascending order and represents the time chat conversation took place. 

Screen Names - This column displays the screen names of both the person sending and the 
person receiving chat conversation for a specific time. The user's (family member) screen name 
appears in red text. 

Chat Conversation - This column displays the actual conversation text for a specific time. 

10. Click Chat Detail located below the table to return to the first level of Chat Detail. 

11. Observe the remaining table columns. 

Count - Displays total number of messages sent. This is the last level of transaction detail. 

Time - Displays total time spent. This is the last level of transaction detail. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of 
report results. 

 
! Clicking the navigation link Graphs, located below the table or the Reporting tab, will refresh Chat 

activity and return to reporting OR click Chat Detail will display Chat transaction detail. 

 
! Clicking Back from the Standard Buttons toolbar will return to reporting but will not refresh Chat 

activity. 

 

Chat Messages 

A line chart that represents the number of messages sent within a specified date or time range. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Chat if necessary. 
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4. Click GO. 

5. Observe the Chat Messages report graph. Resting the mouse pointer over an intersection between the 
line and graph displays the number of messages sent within a specified date range. 

  

6. Click a specific portion of the line chart to drill-down to Chat Report Detail. A table displays an individual 
user summary listing names (User), the number of messages (Count), and time spent (Time Spent). 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 

 
8. Click a user name to drill-down another level to chat transactions. 

9. Observe the table. This is the last level of transaction information. 

 
Let's define each column of information detail:  

Time - Time is listed in ascending order and represents the time chat conversation took place. 

Screen Names - This column displays the screen names of both the person sending and the 
person receiving chat conversation for a specific time. The user's (family member) screen name 
appears in red text. 

Chat Conversation - This column displays the actual conversation text for a specific time. 

10. Click Chat Detail located below the table to return to the first level of Chat Detail. 
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11. Observe the remaining table columns. 

Count - Displays total number of messages sent. This is the last level of transaction detail. 

Time - Displays total time spent. This is the last level of transaction detail. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of 
report results. 

 
! Clicking the navigation link Graphs, located below the table or the Reporting tab, will refresh Chat 

activity and return to reporting OR click Chat Detail will display Chat transaction detail. 

 
! Clicking Back from the Standard Buttons toolbar will return to reporting but will not refresh Chat 

activity. 

Chat Apps  

A pie chart that represents chat (Instant Messaging, IM) applications used on your machine. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Chat if necessary. 

  

4. Click GO. 

5. Observe the Chat Apps report graph. Resting your mouse pointer over each pie wedge displays how 
many messages were sent using that specific chat application during a specified date range. 

  

6. Click on a pie wedge to drill-down to Chat Report Detail. A table displays an individual user summary 
listing names (User), the number of messages (Count), and time spent (Time Spent). 

7. Observe the name of the chat application is displayed in the Report Settings Bar. 
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8. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 

 
9. Click a user name to drill-down another level to chat transactions. 

10. Observe the table. This is the last level of transaction information. 

 
Let's define each column of information detail:  

Time - Time is listed in ascending order and represents the time chat conversation took place. 

Screen Names - This column displays the screen names of both the person sending and the 
person receiving chat conversation for a specific time. The user's (family member) screen name 
appears in red text. 

Chat Conversation - This column displays the actual conversation text for a specific time. 

11. Click Chat Detail located below the table to return to the first level of Chat Detail. 

12. Observe the remaining table columns. 

Count - Displays total number of messages sent. This is the last level of transaction detail. 

Time - Displays total time spent. This is the last level of transaction detail. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs, located below the table or the Reporting tab, will refresh Chat 

activity and return to reporting OR click Chat Detail will display Chat transaction detail. 

 
! Clicking Back from the Standard Buttons toolbar will return to reporting but will not refresh Chat activity. 
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Chat Sites 

A bar chart that represents visited chat-related websites and the number of times that chat site was accessed. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click View Reports). 

2. Select a User and Date Range. 

3. Change the Access Type to Chat if necessary. 

  

4. Click GO. 

5. Observe the Chat Sites report graph. Resting your mouse pointer over each bar displays the chat-related 
websites visited and the number of times that chat site was accessed. 

  

6. Click on a bar to drill-down to Chat Report Detail. A table displays an individual user summary listing 
names (User), the number of messages (Count), and time spent (Time Spent). 

7. Observe the report sample below and the results total (i.e., Results: 1 to 20 of 155). Clicking a column 
heading will sort column data in ascending or descending order. 
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8. Click a user name to drill-down another level to chat transactions. 

9. Observe the table. This is the last level of transaction information. 

 
Let's define each column of information detail:  

Time - Time is listed in ascending order and represents the time chat conversation took place. 

Screen Names - This column displays the screen names of both the person sending and the 
person receiving chat conversation for a specific time. The user's (family member) screen name 
appears in red text. 

Chat Conversation - This column displays the actual conversation text for a specific time. 

10. Click Chat Detail located below the table to return to the first level of Chat Detail. 

11. Observe the remaining table columns. 

Count - Displays total number of messages sent. This is the last level of transaction detail. 

Time - Displays total time spent. This is the last level of transaction detail. 

Note: Navigation is made easy by: 

! Clicking any of the page links below the table will display Next, Previous, or a specific page of report 
results. 

 
! Clicking the navigation link Graphs, located below the table or the Reporting tab, will refresh Chat 

activity and return to reporting OR click Chat Detail will display Chat transaction detail. 

 
! Clicking Back from the Standard Buttons toolbar will return to reporting but will not refresh Chat activity. 

Remote Management Overview 
Remote Management allows the Administrator to remotely disable or enable access to specific ContentProtect 
categories and services or even mark any user inactive (all Internet access is denied). 

Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 
 

Changes that can be made remotely are: 

! Status (active or inactive) - this is applied to specific profiles. 

! Passwords 

! Access Type - switching between services (Chat, Web, or Peer-to-Peer). 
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! Access Allowed - this action applies to all services. 

! Category Status - Allow, Warn, or Block for Web services. 

! Override - enable or disable the ability to override blocked content. 

Other changes to profile information are made through the computer with ContentProtect installed. 

Accessing Remote Management 
A useful option in ContentProtect is that you don't have to be at home to view reports or perform remote 
management for your home Internet and Chat usage. When enabled through a subscription-based Premium 
Service, and as long as you have Internet access (no matter where you are), you can keep in touch with Internet 
and Chat activity in your home. 

Note: If you are using a computer with ContentProtect installed, use the following steps: 

1. Sign in as Administrator, open ContentProtect, and click View Reports. 

2. Select the Remote Management tab. The tab will be yellow meaning it is active. 

 

There are two ways to access Remote Management away from home: 

Option 1: 

1. Launch the browser from any computer with Internet access. 

2. Type cp.contentwatch.com in the Address bar of your browser. 

3. Press Enter. 

4. If you receive the Security Alert shown below, click OK to continue. 

 
5. Observe the sign in screen. 
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6. Enter your ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD. 

If you are the Administrator and have forgotten your password, click as directed for the option to email a 
password request or you can email direct to info@contentwatch.com. You can also contact Customer 
Support toll free at 1-800-485-4008 for prompt, courteous service. 

7. Click SIGN IN. 

8. Select the Remote Management tab. The tab will be yellow meaning it is active. 

 
 Option 2: 

1. Launch the browser from any computer with Internet access. 

2. Type http://www.contentwatch.com/protect/login.php in the Address bar of your browser. 

3. Press Enter. 

4. Observe the Log In page. Enter your ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD. 

 
If you are the Administrator and have forgotten your password you can email direct to 
info@contentwatch.com. You can also contact Customer Support toll free at 1-800-485-4008 for prompt, 
courteous service. 

8. Click Log In. 

9. Select the Remote Management tab. The tab will be yellow meaning it is active. 

 

mailto:info@contentwatch.com
http://www.contentwatch.com/protect/login.php
mailto:info@contentwatch.com
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Selecting a User for Remote Management 
Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

The following steps are based upon using the computer with ContentProtect installed. 

1. Sign in as Administrator, open ContentProtect, and click Remote Tools 

2. Select the Remote Management tab. 

3. Click the drop-down arrow to display a user list located at the left. Observe the illustration above. 

4. Select a user. 

 
5. Click Go. 

Make sure that the user name is displayed. 

 

Note: If you are away from the family computer, you can sign in on any computer with Internet access (if you are 
a Premium Service subscriber). Choose one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the Log in page. 

Changing the Status - Inactive or Active 
The user profile can have the access status changed from being active to inactive for each specific user. This 
action applies to all services. 

Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

Note: The sign in step below is based upon using the computer with ContentProtect installed. 

! Sign in as Administrator, open ContentProtect, and click Remote Tools 
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Making a profile inactive: 

1. Make sure the Remote Management tab is selected. 

2. Select a user from the drop-down list. 

 
3. Click Go. 

This will display the current settings for the selected user. 

4. Select the radio button next to Inactive. 

  

5. Click Apply to save changes. 

The text (PROFILE UPDATED) will appear confirming changes have been applied. 

Making a profile active: 

1. Make sure the Remote Management tab is selected. 

2. Select a user from the drop-down list. 

  
3. Click Go. This will display the current settings for the selected user. 

4. Select the radio button next to Active. 

 
5. Click Apply to save changes. 

The text (PROFILE UPDATED) will appear confirming changes have been applied. 

      6.  To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 
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Changing a Password Remotely 
The sign-in password can be changed as often as needed. The Administrator can change passwords without 
needing to know the current password being used for a user. A forgotten password is quickly eliminated. 

Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

You can also change a password locally. Refer to Changing a Password Locally. 

Important: If the Administrator forgets their Administrator password, choose one of the following: 

• If you have more than one Administrator setup, the other Administrator can tell you your password or 
change your password for you. 

• Send a password request to info@contentwatch.com or call Customer Support at 1-800-485-4008. 
Please provide the following information: 

• Administrator Name 

• Registration Key 

• Account Name 

• Email Address (where to send password) 

• Secret Question 

• Answer to Secret Question 

  

Changing a Password away from home: 

1. Open the browser (Internet Explorer or Netscape). 

2. Type cp.contentwatch.com in the Address bar of your browser and press Enter. 

3. Enter ACCOUNT NAME, ADMINISTRATOR ID, and PASSWORD 

  

mailto:info@contentwatch.com
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4. Click LOG IN. 

5. Select the Remote Management tab. 

6. Select a user from the drop-down list. 

 

 
7. Click Go. 

8. Click the linked text Change password. 

 
9. The screen is displayed where a new password can be entered. 

  

10. Enter the new password in the Enter new password text box. 

Passwords are not case sensitive and have a 40-character limit. Numbers and alpha characters can be 
combined. 

11. Enter the password again in the Confirm new password text box. 

12. Click Change Password to save changes. 

The text (PASSWORD CHANGED) will appear confirming changes have been applied. 

      13. To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 

Changing the Access Type  
The access type can be changed for each profile so settings can be modified individually for Chat, Web, 
Newsgroups or Peer-to-Peer services. The Web access type can have the access status modified for each 
category (Allow, Warn, or Block). Access can be allowed or denied for all three. 
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Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

The following steps are based upon using the computer with ContentProtect installed.  

Note: If you are away from the family computer, you can sign in on any computer with Internet access. Choose 
one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

! Type www.contentwatch.com in the Address bar of your browser and press Enter. Locate and click the 
link to access Web-based Reporting. You can then sign in from the sign in screen. 

 

1. Sign in as Administrator, open ContentProtect, and click Remote Tools. 

2. Select the Remote Management tab. 

3. Select a user or the entire family from the drop-down list. 

4. Click Go. 

5. Click the drop-down arrow under Access Type and choose Chat, Web, Newsgroups or Peer-to-Peer. 

  

Note: If selecting Web, you can make changes to the access status for each category. The Chat access type 
does not have categories. Access can be allowed or denied for all services. 

6. Click Apply to save your changes. 

The text (PROFILE UPDATED) will appear confirming changes have been applied. 

      7. To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 

Changing Override Status 
An Administrator can change the Override status for any user enabling them to override blocked content with the 
appropriate password. Just select yes or no. 

Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

The following steps are based upon using the computer with ContentProtect installed. 

Note: If you are away from the family computer, you can sign in on any computer with Internet access. Choose 
one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

  

1. Sign in as Administrator, open ContentProtect, and click View Reports. 

2. Select the Remote Management tab. 

3. Select a user from the drop-down list. 

4. Click Go. 
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5. Select Yes or No appropriately. The Override Password status is set as No by default. 

 
6. Click Apply to save changes. 

7. To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 

Denying Access 
Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from 
the menu. 

Note: If you are away from the family computer, you can sign in on any computer with Internet access. Choose 
one of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

The following steps are based upon using the computer with ContentProtect installed. 

 
Denying Internet access to Web, Chat, Newsgroups or Peer-to-Peer services: 

1. Sign in as Administrator, open ContentProtect, and click View Reports. 

2. Make sure the Remote Management tab is selected. 

3. Select a user. 

4. Click Go. 

5. Select an Access Type (Web, Chat, Newsgroups or Peer-to-Peer). 

6. Remove the check mark from Access Allowed. 

  
7. Click Apply to save changes. 

The text (PROFILE UPDATED) will appear confirming changes have been applied. 
 

Restoring Internet access to Web, Chat, Newsgroups, or Peer-to-Peer services: 

1. Sign In as Administrator, open ContentProtect, and click View Reports. 

2. Make sure the Remote Management tab is selected. (add something about clicking refresh profiles to 
pull updated profile info from server) 

3. Select the user. 

4. Click Go. 

5. Select an Access Type (Web, Chat, Newsgroups or Peer-to-Peer). 
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6. Check Access Allowed.  

  

7. Click Apply to save changes. 

8. Click Refresh Profiles on the machine where ContentProtect is installed. 

The text (PROFILE UPDATED) will appear confirming changes have been applied. 

      9.  To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles 

Access Status for Categories 
Provides access to appropriate content according to the maturity and needs of each user and according to your 
family values. 

Any changes made while in Remote Management will be reflected in ContentProtect under User Profile and 
Filter Settings and vice-versa. In order for the changes to take affect, the Administrator must log on to the 
computer where ContentProtect is installed, right click on the system tray icon, and click Refresh Profiles from the 
menu. 

Note: you are away from the family computer, you can sign in on any computer with Internet access. Choose one 
of the following options: 

! Type cp.contentwatch.com in the Address bar of your browser and press Enter. You can then sign in 
from the sign in screen. 

The following steps are based upon using the computer with ContentProtect installed. 

 

1. Sign in as Administrator, open ContentProtect, and click View Reports. 

2. Make sure the Remote Management tab is selected.  

3. Select a user. 

4. Click Go. 

5. Select Web as the Access Type to display the setting options for categories. 

6. Click the drop-down arrow for the category you want to modify. 

 
7. Select Allow, Warn, or Block. 

8. Repeat as necessary for each category. 

9. Click Apply to save changes (scroll down if necessary). 

10. Click Refresh Profiles on the machine where ContentProtect is installed. The text (PROFILE UPDATED) 
will appear confirming changes have been applied. 
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Review the list below for Access Status codes, descriptions, and user prompts: 

Allow - Provides access without restriction. No message is displayed and the user is allowed access to 
the requested page. 

Warn - Provides access but warns the user of the types of content they are about to view and lists the 
category types that have caused the warning. A warning message is displayed but the user can choose to 
view the requested page. 

Click Continue (to display the requested web page), Go Back (to return to the previous website), or Re-
Categorize URL (this option applies to Administrators only).  

 
Block - Prompts the user that the attempted website is being blocked and lists the category types that have 
blocked it. The requested page will not open. 

Click Go Back (to return to the previous website).  

 
Block with Override option - Prompts the user that they are being blocked and lists the category types that have 
blocked it. Both users and Administrators can override this block with a password. The Administrator will have to 
give the override password to the user. 

Click Override (to enter the override password and then click OK), Go Back (to return to the previous 
website), or Re-Categorize URL (to select a category to assign the URL to and apply by clicking OK). 
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 Categories that are defaulted to Block a requested page are: 

! Adult/Mature 

! Pornography 

! Drugs/Alcohol 

! Gambling 

! Hate/Violence 

! Illegal Activities 

! Intimate Apparel 

All other categories are set to allow access. Adjustments can be made to all categories. For a list of 
ContentProtect categories and descriptions click here. 

Recategorizing a URL  
You can recategorize URL's while away from home. As long as you have an Internet connection, this feature will 
come in handy. 

1. Access Reporting. (Double-click ContentProtect from the system tray and click Remote Tools). 

2. Select a User and Date Range. 

3. Change the Access Type to Web if necessary. 

  

4. Click GO. 

5. Observe the different Web report graphs. 

 
6. Click any portion of any one of the graphs to generate and display Web Report Detail. 

7. Observe the report sample below. This is the first level of transaction detail. 
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8. Under the column # of Visits, click any one of the reported numbers to display a second level of 

transaction detail. 

9. Observe the website printed in orange text. This website can be recategorized if necessary. 

 
10. Click [Recategorize] to recategorize the website (i.e. gambling.com), if necessary. 

11. Select a new category from the drop-down list. 

 
12. Click Recategorize to apply the changes.  

13. To update changes to the client, go to Computer with ContentProtect installed and Refresh Profiles. 
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Glossary 
Administrative Privileges - Assigning a user the same access as the Administrator. 

Administrator - The person who is responsible for setting up and maintaining a group of users. Duties of the 
Administrator include installing ContentProtect, setting up and managing user profiles, assigning passwords and 
privileges, etc. 

Application - Software, program, or tool used on your computer, such as a word processor, a game, or an email 
program. 

Browser - The application that let's you navigate around and view pages on the Web. Netscape and Microsoft 
Explorer are the two most common. 

Category - A general term for a whole topic or information type. 

Chat - Real time communication. Typed conversation that is received almost instantly as soon as it is sent. 
Talking live with one or more people via the Internet. It's like a party line, except you type instead of talk. 

Client-Based Filtering - Filtering that is performed from an individual computer. Filtering software and a list of 
categorized sites are stored on an individual computer which makes filtering more flexible for the user making 
decisions about acceptable content. Aside from restricting Internet access to certain websites, many client-based 
filters also offer controls for other Internet services. 

Default Settings - A setting that a program is pre-set to select (usually the recommended settings) if you do not 
specify other options. 

Drill Down - To move from a summary of information to more detailed data. To drill down through a series of 
reports addressing more detail at each level. 

Filtering - Controlling access to a web page request by analyzing the incoming and outgoing requests and letting 
them pass or halting them based on settings selected within ContentProtect. 

Guest Profile - Typically a single, generic, limited profile set up for visitors and friends to use. 

Hacker - Slang term for an individual who tries to gain unauthorized access to computer systems for the purpose 
of stealing or corrupting data. 

Help - Online documentation. Many programs come with the instructional manual, or a portion of the manual, 
integrated into the program. If you encounter a problem or forget a command while running the program, you can 
access help documentation by selecting Help from the Menu bar and clicking a topic for help documentation. 

Icon - A small picture that represents an object or program. 

Internet - The Internet consists of countless networks of computers that are connected together across the world 
allowing millions of people to share information. Components of the Internet include: the World Wide Web, 
newsgroups, chat rooms, and e-mail. 

Log - A program or system that enters a record into a log file or report file. 

Peer-to-Peer - Peer-to-peer networks exist on the Internet which allow users to have access to other users' files 
residing on their hard disks. ContentProtect currently blocks Peer-to-Peer activity only on the Gnutella network. 

Portable User Profiles - Allows a user to install the filter on more than one computer and have settings 
transferred automatically. This is very useful for multiple computer households or in a situation where a computer 
breaks down or is outdated and needs to be replaced. 

Remote Management - The capability of accessing files, devices, and other resources not connected directly to 
your workstation. In the case of ContentProtect, reviewing report results and managing user profiles can be 
performed from any machine having Internet access (When enabled through a subscription-based Premium 
Service). 

Screen Name - An identifier that consists of a sequence of one or more alpha or numeric characters that uniquely 
identifies a person. 
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Server-Based Categorization and Validation - A server that maintains a list of categorized URLs (Universal 
Resource Locator). The server is updated regularly to ensure that all users are getting the most up to date 
accurate information. The server does not actually deliver the requested web page (URL) to the customer but 
compares the requested URL to the list. 

Shortcut Menu - A popup menu that appears by right-clicking an object. When left-clicking once or right-clicking 
the ContentProtect icon from the System Tray located in the Taskbar, the same popup menu is displayed. 

System Tray - Located on the Windows Taskbar (usually at the bottom next to the clock) contains miniature icons 
for easy access to system functions such as fax, printer, modem, volume, and more. 

Taskbar - A system bar located at the bottom of your screen. The Taskbar is home base for the Start button, 
system clock, system tray, etc. 

Transaction detail - Activity information based on report results. 

Tutorial - An interactive multimedia presentation that explains program features. 

URL - Universal Resource Locator. An address on the Internet, the URL shows the specific path that locates a 
site or a document online. The URL for a Web page looks like this: 

http://www.domain name/folder name/filename 

User - An individual who uses a computer. 

User ID - An identifier that identifies a specific user in a program. 

User Profile - Program settings that are specific to an individual user. 

WWW - World Wide Web - The Web is the visual component of the Internet. Created with HTML language, Web 
pages can include text, pictures, sound clips, video, links for downloading software, and much more. The Web is 
only one component of the Internet, although the terms are often (and mistakenly) interchanged. 

Web-Based Reporting - Reports that have compiled Web and Chat activity for a ContentProtect family and are 
accessible from any computer with Internet access (When enabled through a subscription-based Premium 
Service). 

Frequently Asked Questions (FAQs) 
Can I be notified at work when my kids are trying to view inappropriate sites? 
As the Administrator you can specify an email address where you would like to receive notices. You can set each 
profile to send a notice for one, or all of the following: 
! When a user receives a warn message 
! When a user receives a blocked message 
! When a user overrides a block 

 
How do I get email notifications at work? 
Sign in as Administrator; locate the Administrator Settings section of that window. Check the check box “I want to 
receive email notifications”, enter an accurate email address where you want to receive notifications, and click 
Apply. 
 
Can I make changes to my child's profiles from work? 
ContentProtect has the unique option to allow you to remotely manage profile settings (When enabled through a 
subscription-based Premium Service). You can access Web-based reporting from cp.contentwatch.com and 
select the Remote Management tab to make changes to specific profile settings. 
 
Can my kids disable ContentProtect software? 
We have gone to great lengths to make sure that ContentProtect will be difficult to bypass. A password is required 
to uninstall or make any alterations to settings. 
 
Do I have to change my ISP account to use ContentProtect? 
No, ContentProtect will function with most ISPs. Since ContentProtect is installed on your computer it doesn't 
conflict with anything your ISP is doing. 
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Does ContentProtect work with AOL? 
ContentProtect will work with AOL version 6.0 and above. 
 
Does ContentProtect work with personal firewalls? 
ContentProtect is compatible with most popular commercially available firewall software. Call customer support if 
you are having problems. 
 
How do I change the override password? 
As the Administrator, you can open ContentProtect and click Change Override Password under Advanced 
Options. Enter a new password (text is visible so be careful not to let anyone have a peek). Click OK to save 
changes. 
 
I can see the name of the site my kids went to but it doesn't really tell me what kind of site it is. 
ContentProtect online reports allow you to drill-down into the details of each individual user to view their Internet 
transactions. The actual URL names that appear on the reports are live links that allow you to open and view 
each site. 
 
I have more than one computer; can I use the same settings on all of them? 
Yes, ContentProtect is very portable that way. By importing existing accounts during installation, the original 
settings follow you to each machine. This is also very useful when a computer needs to be replaced. During 
installation, select Import an existing account, click Next, enter Account Name, Administrator ID, and Password, 
and then click Finish. 
 
I have problems starting Yahoo messenger after installing ContentProtect, what do I do? 
Go into preferences on Yahoo messenger and select the Connection category, make sure that connection is set 
to Firewall with no proxies; you should then be able to connect. 
 
If I want another person to be an Administrator too, how do I do that? 
ContentProtect allows you to assign as many Administrators as you need. Simply check the box Administrator 
under the User Profile tab and enter an accurate email address, if they want to receive notifications, and then click 
Apply. Once a user is assigned to be an Administrator, they can open ContentProtect, view reports, and remote 
manage profiles. 
 
What if I forget my Administrator password? 
If you have more than one Administrator setup, the other Administrator can tell you or change your password. You 
can also contact ContentWatch Customer Support by email at info@contentwatch.com and provide the following 
information. 
! Administrator Name 
! Registration Key 
! Account Name 
! Email Address (where to send password) 
! Secret Question (What's my dog's name) 
! Answer to Secret Question 

 
Actual conversations using MSN or Netscape chat are not logged. Why is this? 
Currently ContentProtect monitors and logs specific Instant Message and Chat applications. Because MSN and 
Netscape display chat data through a modified web browser, the chat session looks like a web page had been 
accessed. ContentProtect will report on the accessed page but it will not log the actual conversations taking 
place. This will be addressed in future releases of ContentProtect. 

Open Code License Text 
 
PCRE License Lext: 
Regular expression support is provided by the PCRE library package, which is open source software, written by 
Phillip Hazel, and copyright is by the University of Cambridge, England. 

ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 

mailto:info@contentwatch.com
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SOAP License Text: 
This product includes software developed by the Apache Software Foundation. 

http://www.apache.org/ 
  
OpenSSL License Text: 
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. 

http://www.openssl.org 
   


	ContentProtect User Guide
	Welcome to ContentProtect
	System Requirements and Key Features
	Installation
	Signing In and Out as a User
	Signing In and Out as Administrator
	Opening and Closing ContentProtect
	ContentProtect Windows
	Adding a User Profile
	Filter Settings Overview
	Changing Filter Settings
	Denying or Allowing Web, Chat, Newsgroups or Peer-to-Peer Access
	Defining Filter Types
	Duplicating a User Profile
	Adding an Administrator
	Deleting a User Profile
	Modifying Profile Settings
	Time Restrictions Overview

	Termination of Internet Connection
	Setting Time Restrictions
	Modifying Time Restrictions
	Changing a Password Locally
	Categories
	Advanced Options Overview
	Changing the Override Password
	Recategorizing a URL Overview
	Recategorizing a URL
	Filter Sensitivity Overview
	Changing Filter Sensitivity
	Online Updates
	Reporting Overview
	Local Reporting

	Accessing Local Reports
	Generating Local Reports for a Specific User
	Generating Local Chat Reports
	Web-based Reporting
	Accessing Web-Based Reporting
	Generating Web-based Reports for a Specific User
	Customizing Web-based Report Defaults
	Web Reporting Overview
	Time Spent Online
	Web Usage
	Categories Logged
	Filter Actions
	Chat Reporting Overview (online reports)
	Time Spent in Chat
	Chat Messages
	Chat Apps
	Chat Sites

	Remote Management Overview
	Accessing Remote Management
	Selecting a User for Remote Management
	Changing the Status - Inactive or Active
	Changing a Password Remotely
	Changing the Access Type
	Changing Override Status
	Denying Access
	Access Status for Categories
	Recategorizing a URL
	Glossary
	Frequently Asked Questions (FAQs)
	Open Code License Text


